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Designer 1 1 Using SAP NetWeaver BW in Universe Designer This guide is intended to help you create and manage OLAP universes based on SAP
NetWeaver BW data sources. The universes can be used in Web Intelligence, Dashboard and Analytics, Live Office, and Query as a Web Service. An OLAP
universe is a Business Objects universe that has been generated from an OLAP cube or query. The universe is created automatically from a selected
connection to an OLAP data source. You generate and maintain an OLAP universe in the following way: · · To generate an OLAP universe, first select the
SAP NetWeaver BW data source. Define a connection to the data source using the New Connection wizard, and select the connection for a new universe.
Designer generates the universe automatically. OLAP structures are mapped directly to classes, measures, dimensions, details, and filters in the universe. The
universe structure appears in the Universe pane.
· · · You can save and export the OLAP universe to the CMS. You can modify any of the OLAP universe components. The Update OLAP Universe wizard
allows you manage the lifecycle of the OLAP universe. The wizard automatically refreshes the universe structure with changes made in the OLAP data
source. The wizard can differentiate generated objects from objects added or modified manually, allowing you to preserve the manual changes made in
Designer. Note: This guide sometimes refers to other OLAP data sources, or OLAP data sources in general. In these cases, the information applies equally to
SAP NetWeaver BI data sources. Related Topics · · · · · Prerequisites to using SAP NetWeaver BW in Universe Designer on page 23 SAP NetWeaver Business
Warehouse (BW) data sources on page 19 Designer features supported for OLAP universes on page 44 About OLAP universe lifecycle management on page
60 How SAP NetWeaver BW objects are mapped and used in a universe on page 106 8 Using SAP NetWeaver Business Intelligence in Universe Designer
Prerequisites to using SAP NetWeaver BW in Universe Designer 2 2 Prerequisites to using SAP NetWeaver BW in Universe Designer When creating a
universe from an SAP NetWeaver BW data source, you can enable SSO (Single Sign On) for view time.
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SSO allows users to log on to BusinessObjects Enterprise with their SAP Credentials and leverage SAP Authentication. To enable SSO for OLAP Universes
on top of SAP, you must install the SAP Integration and configure the SAP Security Plug In.
Once SAP security integration is configured, you can use SAP credentials to launch Designer. Create the BusinessObjects Enterprise user name by
concatenating the SAP System ID and SAP Client ID as defined when configuring the security integration with the SAP user ID. For more information, see the
Business Objects XI Integration for SAP Solutions Installation Guide, and the Business Objects XI Integration for SAP Solutions User Guide. 10 Using SAP
NetWeaver Business Intelligence in Universe Designer SAP NetWeaver Business Warehouse (BW) data sources 3 3 SAP NetWeaver Business Warehouse
(BW) data sources SAP NetWeaver Business Warehouse (BW) InfoCubes as data sources When creating an OLAP universe based on a NetWeaver BW data
source, you can build the universe based directly on an InfoCube/MultiCube, or based on a BW Query enabled on top of any InfoPSAP OLAP Business
Application Programming Interface (BAPI) support level NetWeaver BW metadata feature Characteristics (incl. Time and Unit) InfoCube/BW Query
Hierarchies Basic Key Figures Navigational Attributes Display Attributes Calculated Key Figures / Formulas Restricted Key Figures Custom Structures
InfoCube/BW Query InfoCube/BW Query BW Query only InfoCube/BW Query BW Query only BW Query only BW Query only 14 Using SAP NetWeaver
Business Intelligence in Universe Designer SAP NetWeaver Business Warehouse (BW) data sources SAP NetWeaver BW multilingual universes 3 NetWeaver
BW metadata feature SAP OLAP Business Application Programming Interface (BAPI) support level BW Query only Variables · · BW Queries offer a flexible
extension to the data modeling environment.
InfoCubes require more effort to change. BW Queries offer significant functionality to create customized data sources that meet end-user requirements.
Although BW Queries have advantages as data sources, you do not need a BW Query for every report, nor do you need a universe for every existing BW
Query. To minimize maintenance costs, focus the implementation strategy on limiting the final number of BW Queries and universes required to meet all the
ad-hoc query and reporting needs. Keep in mind the following points to reduce the number of universes needed: · · When Web Intelligence is the front-end
tool, you are not restricted by the output format in the BW Query.
There is no direct impact on performance when working with OLAP universes created from large BW Queries. OLAP universe objects not inserted in the Web
Intelligence query have no direct impact on the query performance. Note: Business Objects recommends having a few BW Queries from a single one to a
handful of them for every InfoCube or MultiCube that is in scope for ad-hoc query and reporting. Then build a universe on top of each of these BW Queries.
SAP NetWeaver BW multilingual universes With Web Intelligence, it is possible to leverage the multilingual capabilities of SAP NetWeaver BW. In order to
implement a multilingual environment, the NetWeaver BW system must include multilingual metadata and multilingual data. Using SAP NetWeaver Business
Intelligence in Universe Designer 15 3 SAP NetWeaver Business Warehouse (BW) data sources SAP NetWeaver BW multilingual universes You must create a
universe for each language supported by the solution. The language in which the universe connection is created determines the language in which the
universe is generated. The user's SAP authentication determines the language of the data returned to the query. The user must log into InfoView using SAP
authentication and specify the desired language for results returned from the SAP server.
The result-set language is dependent on SAP's Unicode support. If the SAP system does not contain the data in the desired language, the data is not available
in Web Intelligence in this language. Web Intelligence reverts to displaying technical names instead of descriptions when the descriptions are not translated
in NetWeaver BW. 16 Using SAP NetWeaver Business Intelligence in Universe Designer About OLAP universes 4 4 About OLAP universes What is an OLAP
universe? What is an OLAP universe? An OLAP universe is a Business Objects universe that has been generated from an OLAP cube or query. The universe
is created automatically from a selected connection to an OLAP data source. Once the universe has been created, it can be exported to the Central
Management Server (CMS) as any other universe. The universe is then available to Web Intelligence users to run queries and create reports. You generate
and maintain an OLAP universe in the following way: · · To generate an OLAP universe, first select the OLAP data source. Define a connection to the data
source using the New Connection wizard, and select the connection for a new universe. Designer generates the universe automatically.
OLAP structures are mapped directly to classes, measures, dimensions, details, and filters in the universe. The universe structure appears in the Universe
pane. · · · You can save and export the OLAP universe to the CMS. You can modify any of the OLAP universe components. The Update OLAP Universe wizard
allows you manage the lifecycle of the OLAP universe.
The wizard automatically refreshes the universe structure with changes made in the OLAP data source. The wizard can differentiate generated objects from
objects added or modified manually, allowing you to preserve the manual changes made in Designer. Related Topics · · · · Which OLAP data sources can be
used to create a universe? on page 19 About connections to OLAP data sources on page 28 Designer features supported for OLAP universes on page 44
About OLAP universe lifecycle management on page 60 18 Using SAP NetWeaver Business Intelligence in Universe Designer About OLAP universes Which
OLAP data sources can be used to create a universe? 4 Which OLAP data sources can be used to create a universe? You can use Designer to create OLAP
universes automatically from the following OLAP data sources: · · · · SAP NetWeaver Business Warehouse (BW) Microsoft Analysis Services (MSAS) 2000
Microsoft Analysis Services (MSAS) 2005 Hyperion Essbase One universe is generated automatically from one cube or query. OLAP universes support a
single cube in the universe. Related Topics · · · · · · SAP NetWeaver Business Warehouse (BW) data sources on page 19 How SAP NetWeaver BW objects are
mapped and used in a universe on page 106 MSAS features supported for OLAP universes on page 24 How MSAS cubes are mapped to universe components
on page 119 Essbase features supported for OLAP universes on page 25 How Essbase cubes are mapped to universe components on page 117 SAP
NetWeaver Business Warehouse (BW) data sources When creating an OLAP universe based on a NetWeaver BW data source, you can build the universe
based directly on an InfoCube/MultiCube, or based on a BW Query enabled on top of any InfoProvider.
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An InfoProvider can be: · · · · an InfoCube a MultiCube or Multi-InfoProvider an Operational Data Store (ODS) an InfoSet Related Topics · SAP NetWeaver
Business Warehouse (BW) InfoCubes as data sources on page 20 Using SAP NetWeaver Business Intelligence in Universe Designer 19 4 About OLAP
universes Which OLAP data sources can be used to create a universe? · · SAP NetWeaver BW Queries as data sources on page 20 SAP NetWeaver BW
Queries as recommended data sources on page 22 SAP NetWeaver Business Warehouse (BW) InfoCubes as data sources The following types of InfoCubes are
supported as data sources for building OLAP universes: · · Standard and Transactional InfoCubes: Data and metadata are physically stored in the same SAP
NetWeaver Business Warehouse (BW) system Remote InfoCube: Data is physically stored on a remote system Note: While fully supported, building and
deploying universes on remote InfoCubes is not recommended for ad-hoc query-, reporting-, and analysis-use scenarios. Such architecture is generally not
expected to meet query performance expectations with interactive queries. · MultiCubes and Multi-InfoProviders Note: Building and deploying a Business
Objects universe on top of a MultiCube or Multi-InfoProvider is identical to building and deploying a universe on top of an InfoCube. All the characteristics,
hierarchies, key figures, including time and unit, in the InfoCube are visible in the universe. SAP NetWeaver BW Queries as data sources SAP NetWeaver BW
customers use BW Queries to access SAP Business Explorer front-ends. Note: In order to serve as a data source and become available through the OLAP
interface to Business Objects universes, BW queries must be released for OLE DB for OLAP. You allow external access to the BW Query in the SAP
NetWeaver BW Query Designer, on the Extended tab of the Query Properties dialog box. 20 Using SAP NetWeaver Business Intelligence in Universe
Designer About OLAP universes Which OLAP data sources can be used to create a universe? 4 All InfoObjects in the BW query selected as rows, columns,
and free characteristics are visible in the universe. This includes characteristics, hierarchies, key figures, structures, and variables. Both InfoSets and
Operational Data Stores (ODS) can be exposed to universes via BW Queries.
BW Queries based on an ODS An ODS can be exposed to a universe via a BW Query. ODS objects are often used to manage detailed transaction-level data
before it is aggregated into InfoCubes. Including ODS objects in the NetWeaver data store design is a way to minimize InfoCube size and improve loading
and querying performance. Note: An ODS is usually a large, detailed relational structure. Accessing an ODS via the OLAP BAPI interface does not deliver
ideal query performance. Consider these alternatives to meet end-user expectations for fast report delivery: · · Create direct access to an ODS via BAPI calls
Access the ODS tables using direct SQL in Web Intelligence BI Queries based on an InfoSet An InfoSet can be exposed to a universe via a BW Query. InfoSets
are sometimes defined in SAP NetWeaver BW to report master data. Note: You can report master data by basing the universes on InfoCubes, eliminating the
requirement to go through InfoSets and BW Queries. The key difference between the two approaches is that master data reported off InfoCubes limits data to
valid transactions. Related Topics · SAP NetWeaver BW Queries as recommended data sources on page 22 Using SAP NetWeaver Business Intelligence in
Universe Designer 21 4 About OLAP universes Which OLAP data sources can be used to create a universe? SAP NetWeaver BW Queries as recommended
data sources BW Queries are recommended as data sources for generating Business Objects universes for the following reasons: · Not all SAP NetWeaver
BW metadata features can be retrieved on an InfoCube level, as summarized in the following table.
SAP OLAP Business Application Programming Interface (BAPI) support level NetWeaver BW metadata feature Characteristics (incl. Time and Unit)
InfoCube/BW Query Hierarchies Basic Key Figures Navigational Attributes Display Attributes Calculated Key Figures / Formulas Restricted Key Figures
Custom Structures Variables InfoCube/BW Query InfoCube/BW Query BW Query only InfoCube/BW Query BW Query only BW Query only BW Query only
BW Query only · · BW Queries offer a flexible extension to the data modeling environment. InfoCubes require more effort to change. BW Queries offer
significant functionality to create customized data sources that meet end-user requirements. Although BW Queries have advantages as data sources, you do
not need a BW Query for every report, nor do you need a universe for every existing BW Query.
To minimize maintenance costs, focus the implementation strategy on limiting the final number of BW Queries and universes required to meet all the ad-hoc
query and reporting needs. Keep in mind the following points to reduce the number of universes needed: 22 Using SAP NetWeaver Business Intelligence in
Universe Designer About OLAP universes Which OLAP data sources can be used to create a universe? 4 · · When Web Intelligence is the front-end tool, you
are not restricted by the output format in the BW Query. There is no direct impact on performance when working with OLAP universes created from large BW
Queries. OLAP universe objects not inserted in the Web Intelligence query have no direct impact on the query performance. Note: Business Objects
recommends having a few BW Queries from a single one to a handful of them for every InfoCube or MultiCube that is in scope for ad-hoc query and
reporting.
Then build a universe on top of each of these BW Queries. SAP NetWeaver BW multilingual universes With Web Intelligence, it is possible to leverage the
multilingual capabilities of SAP NetWeaver BW. In order to implement a multilingual environment, the NetWeaver BW system must include multilingual
metadata and multilingual data. You must create a universe for each language supported by the solution. The language in which the universe connection is
created determines the language in which the universe is generated. The user's SAP authentication determines the language of the data returned to the query.
The user must log into InfoView using SAP authentication and specify the desired language for results returned from the SAP server. The result-set language
is dependent on SAP's Unicode support. If the SAP system does not contain the data in the desired language, the data is not available in Web Intelligence in
this language. Web Intelligence reverts to displaying technical names instead of descriptions when the descriptions are not translated in NetWeaver BW.
Prerequisites to using SAP NetWeaver BW in Universe Designer When creating a universe from an SAP NetWeaver BW data source, you can enable SSO
(Single Sign On) for view time.
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SSO allows users to log on to BusinessObjects Enterprise with their SAP Credentials and leverage SAP Authentication. Using SAP NetWeaver Business
Intelligence in Universe Designer 23 4 About OLAP universes Which OLAP data sources can be used to create a universe? To enable SSO for OLAP
Universes on top of SAP, you must install the SAP Integration and configure the SAP Security Plug In. Once SAP security integration is configured, you can
use SAP credentials to launch Designer. Create the BusinessObjects Enterprise user name by concatenating the SAP System ID and SAP Client ID as defined
when configuring the security integration with the SAP user ID. For more information, see the Business Objects XI Integration for SAP Solutions Installation
Guide, and the Business Objects XI Integration for SAP Solutions User Guide. MSAS features supported for OLAP universes The following table summarises
the support level for MSAS features for universes generated from an MSAS data source. MSAS metadata feature Cube Local cube Virtual cube (MSAS 2000)
Perspective (MSAS 2005) Dimensions OLAP universe support level Supported Supported Supported Supported Supported Virtual dimensions (MSAS 2000)
Supported Hierarchies Levels Level Property Attributes (MSAS 2005) Measures Measure group (MSAS 2005) Calculated measures Display folder (MSAS
2005) KPI (MSAS 2005) Supported Supported Supported Supported Supported Supported Supported Supported Not supported 24 Using SAP NetWeaver
Business Intelligence in Universe Designer About OLAP universes Which OLAP data sources can be used to create a universe? 4 MSAS metadata feature
Action Database sort order Write back Related Topics OLAP universe support level Not supported Must define custom sort order in Web Intelligence Not
supported · How MSAS cubes are mapped to universe components on page 119 Essbase features supported for OLAP universes The following table
summarizes the support level for Essbase features for universes generated from a Hyperion Essbase data source. Essbase metadata feature Block storage
mode Aggregate storage mode Hybrid mode Alias tables Dimensions Attribute dimensions Duplicate members Generations Levels User Define Attributes
(UDA) Dynamic Time Series (DTS) Essbase Integration Services (EIS) Drill-through Substitution variables Linked partitions OLAP universe support level
Supported Supported Not supported Supported Supported Supported Supported Supported Not supported Not supported Not supported Not supported Not
supported Not supported Using SAP NetWeaver Business Intelligence in Universe Designer 25 4 About OLAP universes Which OLAP data sources can be
used to create a universe? Essbase metadata feature Linked Reporting Objects (LRO) Database sort order Write back Related Topics OLAP universe support
level Not supported Must define custom sort order in Web Intelligence Not supported · How Essbase cubes are mapped to universe components on page 117
26 Using SAP NetWeaver Business Intelligence in Universe Designer Defining connections to OLAP data sources 5 5 Defining connections to OLAP data
sources About connections to OLAP data sources About connections to OLAP data sources To generate an OLAP universe, you must first define a connection
to the OLAP data source. Define one connection for each cube or query that you want to use to create a universe.
Use the New Connection wizard to define the connection. The wizard leads you through the following steps in creating a connection: · · · · · · Starting the New
Connection wizard in Designer. Naming the connection and selecting the database middleware. Defining the login parameters for the connection. These
parameters vary depending on the database middleware that you selected.
Selecting the cube or query to use to create the universe. Defining the connection life-time. Defining custom parameters. These parameters vary depending on
the database middleware that you selected. Defining a connection is the first step in creating an OLAP universe.
Once you have defined the connection, Designer generates the universe automatically. Note: If you define a connection from the connections list on the Tools
menu, you must create the universe as a separate step. Related Topics · · · · · · · · To start the New Connection wizard in Designer on page 29 To select
database middleware for an OLAP connection on page 29 To define login parameters for SAP NetWeaver BW connections on page 30 Defining login
parameters for MSAS connections on page 32 Defining login parameters for Essbase connections on page 33 To select source cube or query for OLAP
connections on page 34 To define configuration parameters for OLAP connections on page 35 Defining custom parameters for Essbase connections on page
37 28 Using SAP NetWeaver Business Intelligence in Universe Designer Defining connections to OLAP data sources To start the New Connection wizard in
Designer 5 To start the New Connection wizard in Designer To start the New Connection wizard in Universe Designer, do one of the following: Start from...
New Universe icon File menu Do... Click the New Universe icon, then click New..
. on the "Definition" page of the "Universe Parameters" box. From an empty Designer session, select File > Parameters, then click New... on the "Definition"
page of the "Universe Parameters" box. Quick Design wizard If the Quick Design wizard is enabled, it starts automatically when you start Designer. Click
New...
in step one of the Quick Design wizard. Note: If the wizard has been disabled, select File > New. If the wizard does not start when you select File > New,
select Tools > Options. On the "General" page of the "Options" dialog box, select the File/New starts Quick Design wizard check box. Click OK and select
File > New.
Tools menu Select Tools > Connections. Click Add... in the "Wizard Connection" dialog box.
To select database middleware for an OLAP connection On the "Database Middleware Selection" page of the New Connection wizard, enter a name for the
connection, select the type and the database middleware for the connection. Using SAP NetWeaver Business Intelligence in Universe Designer 29 5 Defining
connections to OLAP data sources To define login parameters for SAP NetWeaver BW connections Database Middleware Selection parameter Connection
Type Description Select Secured for controlled access to the connection (recommended). Select Shared to allow uncontrolled access to the connection to all
users. Select Personal to restrict access to the universe creator. You can use personal connections to access personal data on a local machine only.
Connection Name Enter a name for the connection. Filter Stored ProceThe Filter Stored Procedures Network Layers padures Network Layers rameter is not
used for OLAP connections.
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List of available data acThe page lists the databases and middleware that cess drivers. correspond to your data access driver key. Expand the node for your
target database to show the supported middleware for that database.
Expand the middleware node to show the Business Objects data access driver for the OLAP middleware. Select the data access driver. To define login
parameters for SAP NetWeaver BW connections On the "Login Parameters" page of the New Connection wizard, specify the login details for connecting to
the SAP NetWeaver BW database. 30 Using SAP NetWeaver Business Intelligence in Universe Designer Defining connections to OLAP data sources To
define login parameters for SAP NetWeaver BW connections 5 Login parameter Description Select Use Single Sign On when refreshing reports at view time
to allow the user to benefit from SAP SSO. Authentication mode Select Use specified username and password to require the user to enter login information
when using the connection. Select Use BusinessObjects credential mapping to use the user's BusinessObjects Enterprise login credentials for the connection.
User name Enter the SAP User logon. Enter the SAP User password. Enter the SAP client number (required). Enter the connection language, for example EN
for English (required).
Password Client Language Note: The connection language determines the language in which the universe is generated. Select Application server to connect
directly to the SAP server without using load balancing. Login mode Select Message server to benefit from SAP load balancing capabilities. Select or enter
the name or IP address of the SAP application server (required for Application server login mode). Application Server Using SAP NetWeaver Business
Intelligence in Universe Designer 31 5 Defining connections to OLAP data sources Defining login parameters for MSAS connections Login parameter
Description System Number Enter the system number, for example 00 (required for Application server login mode) .
System ID Logon Group Message Server Enter the System ID , Logon Group, and Message Server parameters (required for Message server login mode).
Defining login parameters for MSAS connections On the "Login Parameters" page of the New Connection wizard, specify the login details for connecting to
the MSAS database. Login parameter Description Select Use Single Sign On when refreshing reports at view time to allow the user to benefit from MSAS
2005 SSO. Authentication mode Select Use specified username and password to require the user to enter login information when using the connection. Select
Use BusinessObjects credential mapping to use the user's BusinessObjects Enterprise login credentials for the connection.
User name Enter the MSAS server logon user name. 32 Using SAP NetWeaver Business Intelligence in Universe Designer Defining connections to OLAP data
sources Defining login parameters for Essbase connections 5 Login parameter Password Description Enter the MSAS server logon password. Enter the
server name for the MSAS data source, or enter the full path file name of an MSAS cube file. Enter the full path file name between double quotes, for example:
Server "Z:\All cubes\test.cub" Note: If the cube file is located on a machine different from the BusinessObjects Enterprise machine, the two machines must
have a shared connection. You must create the connection to a cube file directly on the BusinessObjects Enterprise machine. Defining login parameters for
Essbase connections On the "Login Parameters" page of the New Connection wizard, specify the login details for connecting to the Essbase database. Using
SAP NetWeaver Business Intelligence in Universe Designer 33 5 Defining connections to OLAP data sources To select source cube or query for OLAP
connections Login parameter Description Select Use specified username and password to require the user to enter login information when using the
connection. To synchronize Essbase security with BusinessObjects Enterprise, enter the Essbase DBuser and DBpass for User name and Password.
Authentication mode Select Use BusinessObjects credential mapping to use the user's BusinessObjects Enterprise login credentials for the connection.
Note: The Use Single Sign On when refreshing reports at view time option is not supported for Essbase connections. User name Enter the Essbase DBuser.
Enter the Essbase DBpass. Enter the Essbase server name. Password Server To select source cube or query for OLAP connections The cube browser shows
the OLAP cubes available to the target server. Expand the cube nodes to display the cubes and queries available. The browser has the following tools to help
you search: 34 Using SAP NetWeaver Business Intelligence in Universe Designer Defining connections to OLAP data sources To define configuration
parameters for OLAP connections 5 Cube browser tool Description Favorites A folder that holds links to cubes that you select for quick access. To add a cube
to Favorites, right click a cube in the OLAP cube browser and select Add to Favorites from the contextual menu. Searches the names of available cubes or
queries for a text string. Type a string in the text box and click Search.
Each found instance is highlighted. Click Search to continue searching. For SAP NetWeaver BW data sources, the InfoCubes and MultiCubes are grouped in
a folder called $INFOCUBE. Search $INFOCUBE folder Select the cube or query to use to create the universe. To define configuration parameters for OLAP
connections On the "Configuration Parameters" page of the New Connection wizard, define the connection parameters to manage the connection life-time.
You can accept the default settings when you create the connection and modify them later. Using SAP NetWeaver Business Intelligence in Universe Designer
35 5 Defining connections to OLAP data sources To define configuration parameters for OLAP connections Configuration parameter Connection Pool Mode
Description You define the life-time with the Connection Pool Mode and Pool timeout parameters. By default, the Connection Pool Mode is set to Keep the
connection alive for, with a default Pool timeout of 10 minutes. Note: Business Objects recommends you keep the default connection life-time. The universe
building process slows significantly if the Connection Pool Mode is set to disconnect after each transaction.
Disconnecting after each transaction also impacts key end-user workflows such as working with hierarchical list of values. The connection life-time can have
a significant impact when working with SAP NetWeaver BW. Pool timeout However, connection life-time can also impact updating existing universes with
changes in the BW Query. This is because the OLAP BAPI interface builds a metadata cache on the client side every time a connection to SAP NetWeaver BW
is established.
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This cache is only emptied when the connection closes. To minimize the risk of metadata cache being desynchronized with SAP BW Query updates, you can
change the Pool timeout from 10 minutes to 1 minute. When working in parallel editing BW Queries and mapping new universes to these queries, it is
recommended that you close Designer (so that universe connections are also closed and the metadata cache is emptied) before building any new universes to
take into account changes that were just made on the BW Query side. 36 Using SAP NetWeaver Business Intelligence in Universe Designer Defining
connections to OLAP data sources Defining custom parameters for Essbase connections 5 Configuration parameter Array fetch size Array bind size Login
timeout Description The Array fetch size, Array bind size, and Login timeout parameters are not used for OLAP connections. Defining custom parameters for
Essbase connections On the "Custom Parameters" page of the New Connection wizard, specify the alias table and select the dimension to be used as the
Measure dimension when generating the universe. Login parameter Description Alias table To generate the universe on an alias table other than the default,
select the alias table from the list.
Select the dimension to use as the Measure dimension. Designer generates the members of the dimension you select as measures in the universe. Measure
dimension Using SAP NetWeaver Business Intelligence in Universe Designer 37 5 Defining connections to OLAP data sources Defining custom parameters
for Essbase connections 38 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing OLAP universes 6 6 Customizing OLAP universes
Creating OLAP Universes with additional parameters Creating OLAP Universes with additional parameters This feature applies to OLAP universes only and
allows you to define additional metadata parameters when you create an OLAP universe with MSAS, SAP NetWeaver Business Warehouse (BW), or Essbase.
When you create an OLAP universe you can define the following parameters: 40 Using SAP NetWeaver Business Intelligence in Universe Designer
Customizing OLAP universes Defining OLAP options for your OLAP universe 6 Generic OLAP op- Description tions Generate technical You can set the
application to generate the technical name names as details as a detail object of the dimensions in the universe. When the universe is generated, this creates
detail objects that point to the technical names. SAP OLAP options Description Set measures aggre- You can set the application to set the aggregation gation
to delegated function of measures to database delegated. Replace prefixes L00, Universe level prefixes indicate the level in the hierarchy L01, of an object.
Level L00 is the top or root level, L01 is the next level down. @@@@Type your own prefix in the New prefix field. This prefix is prepended to all levels
throughout the OLAP universe.
@@@@This option only applies to SAP Characteristics. You can disactivate this option for Characteristics and hierarchies. Level 00 is always generated for
hierarchy variables. @@The level numbers are appended to the level names (e.g.
"Monthly Sales_L01"). @@This avoids having to create the aggregate field in the Web Intelligence report. Defining OLAP options for your OLAP universe
Use the OLAP options to define how specific universe metadata is generated Using SAP NetWeaver Business Intelligence in Universe Designer 41 6
Customizing OLAP universes Defining OLAP options for your OLAP universe from an OLAP source. You can select OLAP options from the "OLAP" page of
the "Options" dialog box (Tools > Options > OLAP). All content of the OLAP source is extracted and created in the universe depending on selected options.
You can select the following OLAP universe generation options: 42 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing OLAP
universes Defining objects in OLAP universes 6 Generic OLAP op- Description tions Generate technical You can set the application to generate the technical
names as details name of the universe as a property. When the universe is generated, this creates an object that points to the technical name. SAP OLAP
options Description Set measures aggre- You can set the application to generate delegated gation to delegated measures for measures that use the
aggregation function. When the universe is generated, any measures using the aggregation function are set to database delegated. Replace prefixes L00,
Universe level prefixes indicate the level in the hierL01, archy of an object. Level L00 is the top or root level, L01 is the next level down. @@@@Type your
own prefix in the New prefix field. This prefix is prepended to all levels throughout the OLAP universe. This option is disabled if Generate level 00 is set to
No. You can rename the top level (root level) L00 to ALL when the universe is next generated.
@@This avoids having to create the aggregate field in the Web Intelligence report. This option only applies to SAP Characteristics. You can disactivate this
option for Characteristics only. Level 00 is always generated for hierarchies and hierarchy variables. Rename level 00 to All Generate level 00 @@The level
numbers are appended to the level names (e.g. "Monthly Sales_L01") Using SAP NetWeaver Business Intelligence in Universe Designer 43 6 Customizing
OLAP universes Designer features supported for OLAP universes Defining objects in OLAP universes You can use the SQL editor to define a Select statement
or a Where clause for an object, and to insert MDX operators and functions for OLAP universe objects. The options and functions available in the SQL editor
depend on the underlying database. Designer features supported for OLAP universes OLAP universes are created automatically. Once you have created the
OLAP universe, you can modify any of the universe components.
These Designer features are supported for generated OLAP universes: · · · · · · · · · · · · · Hide, duplicate, and rename classes and objects (dimension, detail,
and measure) Insert new classes and objects (dimension, detail, and measure) Edit an object's format Edit an object's data type Define primary and foreign
keys Parse dimension, detail, and measure object MDX syntaxes Check universe integrity Edit hierarchies Create cascading list of values Define a delegate
search for a list of values, allowing users to limit loading of the list of values at query run time Use default values for variables Define measures with
database delegated projection function (smart measures) Refresh the universe structure In addition, the following features are available uniquely for OLAP
universes: · · · Create calculated measures (SAP Netweaver BW and MSAS only) Create pre-defined conditions Define optional prompts All objects based on
OLAP universes are generated with index awareness.
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If there are duplicate values in a hierarchy for an object, index awareness 44 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing
OLAP universes Database delegated projection function 6 eliminates inconsistency in the list of values. For example, say that Paris occurs twice in the
hierarchy, once under the parent France and once under the parent Texas. If the user selects Paris under France, only rows for Paris, France are returned.
The following Designer features are not supported for OLAP universes: · · · You cannot set row-level security authorizations in an OLAP universe.
You cannot edit a list of values in an OLAP universe. You cannot view and edit the universe entity-relationship schema as no schema is generated for OLAP
universes. Related Topics · · · · Calculated measures in OLAP universes on page 49 Predefined conditions in OLAP universes on page 54 Optional prompts in
OLAP universes on page 57 Database delegated projection function on page 45 Database delegated projection function In a universe, any measure can hold
a projection function (Sum, Min, Max, Count, and Avg). The projection function is used to aggregate the measure locally in Web Intelligence when the
number of dimensions displayed in a report is smaller than the number of dimensions in the query result set. Non-additive measures, such as ratio, average,
and weight, can only be shown at the same aggregation level as the query result set.
Therefore, non-additive measures generally have their projection function set to None in the universe. The projection function Database delegated allows you
to delegate the aggregation of a non-additive measure to the database server. These are called smart measures in Web Intelligence. A smart measure has its
projection function set to Database delegated on the properties page of the object properties. Note: For OLAP universes based on MSAS and Essbase data
sources, all measures are created in the universe with the projection function set to Database delegated by default. Using SAP NetWeaver Business
Intelligence in Universe Designer 45 6 Customizing OLAP universes Database delegated projection function Note: Please be aware of the following
limitation when using a smart measure based on a measure that has aggregate aware set: It is strongly recommended to ensure that the aggregate tables used
in the measure definition have consistent data (the aggregate values are accurate regarding detail values) otherwise the smart measures can produce
inconsistent data. For example, if a year aggregate table and a day aggregate table are used for a smart measure, the year aggregate table is consistent with
the day aggregate table for complete years, but for the current year, the year table can be empty while the day table is accurate on a daily basis. In this case,
a report that uses smart measures based on the current year and daily tables can give incoherent results. Example: Smart measure In this example, a query
contains two dimensions: Country and Region, and three measures: Order Amount, Delivered Amount, and % of Delivered Amount. L01 Region Amount
Delivered 497,318,880 199,463,776 198,927,552 Order Quantity % Delivered Reg1 Reg2 Reg3 497,332,680 199,466,536 198,933,072 Sum: 99.
997 99.998 99.997 299.992 The sum for % Delivered is incorrect because it is a summation of the % Delivered column. If this measure has a projection
function set to Database delegated in the universe, when the user refreshes the report, Web Intelligence connects to the database to calculate the correct
value. 46 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing OLAP universes Database delegated projection function 6 L01
Region Amount Delivered 497,318,880 199,463,776 198,927,552 Order Quantity % Delivered Reg1 Reg2 Reg3 497,332,680 199,466,536 198,933,072 Sum:
Total: 99.997 99.998 99.997 299.992 99.
997 Note: The some functions such as the ratio function (Average) must be used with caution. When calculating an average from a column, the behavior of
this function can be unexpected when it is not configured correctly. For example, the SQL function sum(Shop_facts.Mar gin)/sum(Shop.facts.
Quantity_sold) can have unexpected results. When incorrectly configured, it will calculate the average for each cell and return the sum of those averages. To
correct this behavior, the parametrization of the function must be performed as follows: 1. Go to the Edit Properties option for the function. 2.
For the option Choose how this measure will be projected when aggregated, select the Function Db delegated from the Function dropdown list. 3. Save your
changes. Related Topics · Setting aggregate projection for a measure on page 48 Using SAP NetWeaver Business Intelligence in Universe Designer 47 6
Customizing OLAP universes Setting delegated measures for OLAP universes Setting delegated measures for OLAP universes You can set the application to
generate delegated measures for measures that use the aggregation function. When the universe is generated, any measures using the aggregation function
are set to database delegated... Related Topics · · · Replacing OLAP universe level prefixes on page 69 Regenerating Level 00 for OLAP universes on page 68
Renaming level L00 to ALL on page 68 Setting aggregate projection for a measure When you create a measure you must specify the way the aggregate
function will be projected onto a report. Returned values for a measure object are aggregated at two levels of the query process: · · Query level. Data is
aggregated using the inferred SELECT statement.
Microcube to block level. When data is projected from the microcube to the block in a report. This projection function of measures allows local aggregation
in the microcube. Note: A microcube is a conceptual way to present the data returned by a query before it is projected onto a report. It represents the returned
values held in memory by a Business Objects reporting product. The block level is the 2 dimensional report that a user creates with the returned data. A user
can choose to use all, or only some of the data held in the microcube to create a report. A user can also do aggregate functions on the returned values in the
microcube (local aggregation) to create new values on a report. The two levels of aggregation fit into the query process as follows: · · User creates a query in
Web Intelligence. Web Intelligence infers the SQL from the query and sends a SELECT statement to the target database.
48 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing OLAP universes Calculated measures in OLAP universes 6 · · The data is
returned to the microcube. This is the first aggregation level. The microcube projects the aggregated data onto the report.
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Data is split out in the Query pane requiring aggregation to lower levels. This is the second aggregation level.
When you initially make a query the result set of the Select statement is stored in the microcube, and all data then held in the microcube is projected into a
block. As data is projected from the lowest level held in the microcube no projection aggregation is taking place. However, when you use the Query pane to
project only partial data from the microcube, aggregation is required to show measure values at a higher level. For example, in the previous example, if you
do not project the year data into the block, the three rows related to Year need to be reduced to one row to show the overall Sales Revenue for that resort, so a
sum aggregation is used. You set projection aggregation on the "Properties" page of the "Edit Properties" sheet for a measure (right-click Object > Object
Properties > Properties).
Projection aggregation is different from SELECT aggregation. Related Topics · Database delegated projection function on page 45 Calculated measures in
OLAP universes You can create calculated measures in the universe to restrict queries. Calculated measures in OLAP universes are like definitions on the
measure object in non-OLAP universes, except that you define the restriction using MDX functions embedded in XML tags rather than using SQL. Calculated
measures are available for these OLAP data sources: · · SAP NetWeaver Business Warehouse (BW) MSAS 2000 and 2005 Calculated measures can be used in
filters or the where clause. Using SAP NetWeaver Business Intelligence in Universe Designer 49 6 Customizing OLAP universes Calculated measures in
OLAP universes Syntax for calculated measure expressions The syntax for a calculated measure consists of calculations embedded in the tags
<EXPRESSION></EXPRESSION>. Designer functions are allowed in calculated measure expressions, such as: · · · · @Select @Prompt @Variable @Where
Note: Expressions for calculated measures cannot include the @Aggregate_Aware function. Constants are allowed in the expression, for example "10" or
"ABC". Calculated measures can reference any OLAP metadata: · · · · measures dimensions dimension levels MDX expressions The check integrity validates
the XML syntax and any of the Designer functions. Recommendations for calculated measure expressions Use @Select (Measure name) rather than the
measure definition for the following reasons: · · · @Select is resolved at query time. Calculated measures can reference other calculated measures if they are
inside a @Select function.
The validity of objects inside the @Select function is checked. Generate and set the index awareness for each object definition. Use a reference to an object or
detail whose definition refers to the Technical Name or Unique Name of the level or attribute. 50 Using SAP NetWeaver Business Intelligence in Universe
Designer Customizing OLAP universes About MDX functions for cube queries 6 Example: Calculated measure expression <EXPRESSION>@Select(Key
Figures\Order Amount)*@Select(Key Figures\Order Quantity)</EXPRESSION> Related Topics · To create a calculated measure in an OLAP universe on
page 51 To create a calculated measure in an OLAP universe To create a calculated measure in an OLAP universe: 1. In Designer, open an OLAP universe.
2. Insert a new measure object in the universe. 3. In the Where: box, enter or paste the object definition as an XML/MDX expression. 4.
Click Parse to review the object definition and fix any errors. 5. Click OK to save the object definition. 6. Select Tools > Check Integrity.
The integrity check validates the XML syntax and any Designer @FUNCTIONS. Related Topics · Calculated measures in OLAP universes on page 49 About
MDX functions for cube queries Use the MDX editor to define your cube queries. When adding a new object or a predefined filter to an OLAP universe, there
is a list of supported MDX expressions corresponding to the specific data source connection. A library of available expressions is stored in the .prm
connection file.
When you open the Edit Properties pane for an object and opend the Edit Select pane for the query, the available expressions are displayed in the Functions
pane. To insert the expression in the SELECT or WHERE statement, click Using SAP NetWeaver Business Intelligence in Universe Designer 51 6 Customizing
OLAP universes About MDX functions for cube queries in the position in the expression where you want to insert the expression and double-click on the
appropriate expression. OLAP Universe MDX Dictionary - List of Functions (PRM file) When adding a new object or a predefined filter to an OLAP
universe, an explicit list of MDX functions (mainly member functions) and operators is made available in the object and filter editors for the appropriate
OLAP connection (SAP or MSAS) that you can use in the expression. For a description of how to set the connectivity for SAP or mySQL (sap.prm,
sqlsrv_as.prm), refer to the Data Access Guide. The available functions and operators depend on the connection type of the universe. This list of functions is
provided by the PRM file for each connectivity. It does not provide the whole list of supported functions, only the most frequently used functions. The
following MDX operators are available for queries.
· · · · · · · · · · · · Equal Not equal In List Not In List Greater Greater Or Equal Less Less Or Equal Between Not Between Like Not Like The list below shows
examples of some of the available MDX folder functions when editing a condition. The available functions depend on the underlying database. · · · · Set
functions (ADDCALCULATEDMEMBERS, ALLMEMBERS ...) Statistical/Numeric functions (AGGREGATE, AVG ...) Navigation/Member functions
(ANCESTOR, ASCENDANTS..
.) Metadata functions (AXIS, HIERARCHY...) 52 Using SAP NetWeaver Business Intelligence in Universe Designer Customizing OLAP universes XML syntax
for filter and WHERE statements 6 XML syntax for filter and WHERE statements This section describes the XML syntax for defining the WHERE clause or
filter statements in your OLAP universe.
You must add the FILTER or FILTER EXPRESSION tags manually, and then enter your expression between the tags either manually or with Designer's MDX
editor. · Use <FILTER= "your_object_definition"> when using a single object definition. Enter your object definition inside the double quotes. · Use
<FILTER EXPRESSION= "yourcomplexMDX_expression"> when using a complex MDX expression containing one or more objects. Enter your expression
inside the double quotes.
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The syntax for a single filter object is as follows: <FILTER = "your_object_definition"><CONDITION OPERATORCONDI
TION="yourOperator"><CONSTANT VALUE="your_Value"/></CONDI TION></FILTER> Where: · yourMDX_expression is the single object definition,
enclosed in double quotes. · CONSTANTVALUE is either CONSTANT CAPTION or CONSTANT TECH_NAME · yourOperator is the filter expression
operator (equals, inlist...). When the InIist operator is used, you must insert a CONSTANT CAPTION or CONSTANT TECH_NAME element for each item in
the list. · your_Value is the defined filter value when CONSTANT CAPTION is used, or the object identifier if CONSTANT TECH_NAME is used. The syntax
for a single filter object using the InList operator, where three countries are listed, is as follows: <FILTER= "your_object_definition "><CONDITION
OPERATORCONDI TION="InList"><CONSTANT CAPTION="England"/><CONSTANT CAP TION="France"/><CONSTANT
CAPTION="Germany"/></CONDITION></FIL TER> The syntax for a complex filter expression and the TECH_NAME for the filtered value is as follows:
Using SAP NetWeaver Business Intelligence in Universe Designer 53 6 Customizing OLAP universes Predefined conditions in OLAP universes <FILTER
EXPRESSION="yourComplex_MDX_Expression"><CONDITION OP ERATORCONDITION="Equal"><CONSTANT TECH_NAME="1"/></CONDI
TION></FILTER> Example: Filter with a calculated member in the filter expression <FILTER EXPRESSION="IIF([0CALYEAR].CurrentMember >
"2000", 1,0)"><CONDITION OPERATORCONDITION="Equal"><CONSTANT CAP TION="1"/></CONDITION></FILTER> Predefined conditions in
OLAP universes Predefined conditions in OLAP universes are like conditions in non-OLAP universes except that you define the WHERE clause using XML
rather than SQL. To manually create predefined conditions in an OLAP universe To create a predefined condition: 1.
In Designer, open an OLAP universe and click the conditions radio button at the bottom of the Universe pane. The conditions view of the Universe pane
appears. It contains a tree view of the classes in the universe. 2. Right click a class and select Condition... from the contextual menu. 3. In the Where: box, edit
the XML template filter.
The template filter has the format: <FILTER "[Level Object definition]"> <CONDITION OPERATORCONDITION="Operator"> <CONSTANT Level
Attribute="Value"/ </CONDITION> </FILTER> Replace the elements in the template as follows: 54 Using SAP NetWeaver Business Intelligence in
Universe Designer Customizing OLAP universes Predefined conditions in OLAP universes 6 Template element: Level Object definition Operator Possible
Values: Enter the dimension level or measure implied in the filter. Enter the object definition not the object name. Enter one of: · · · · · · · · · · · · Equal Not
Equal Greater than Less than Greater than or equal to Less than or equal to Between Not Between In List Not in List Matches pattern Different from pattern
Level Attribute Enter one of: · · · · NAME CAPTION TECH_NAME DESCRIPTION Value Enter the value or a prompt. Define one value per CONSTANT tag.
An example of an edited predefined condition: <FILTER KEY="[0D_DIV].
[LEVEL01]"> <CONDITION OPERATORCONDITION="InList"> <CONSTANT CAPTION="Internal"/> <CONSTANT CAPTION="Service"/>
</CONDITION> </FILTER> Using SAP NetWeaver Business Intelligence in Universe Designer 55 6 Customizing OLAP universes Predefined conditions in
OLAP universes 4. Click Parse to review the syntax and fix any errors. 5. Click OK to save the condition. Related Topics · · Predefined conditions in OLAP
universes on page 54 Optional prompts in OLAP universes on page 57 XML Syntax for predefined filter options Syntax for predefined conditions A single
predefined condition may contain multiple filters combined with the AND and OR operators.
By default, all filters are combined with the AND operator. To include filters using OR, you must use the AND and OR operator tags. The functions @Select,
@Prompt and @Variable are allowed in the predefined filter definition. Predefined filters can include one or multiple prompts. Prompts can be mandatory or
optional. Example: Using AND and OR tags for pre-defined conditions <OPERATOR VALUE="AND"> <FILTER "[Level Object definition]">
<CONDITION OPERATORCONDITION="Operator"> <CONSTANT Level Attribute="Value"/> </CONDITION> </FILTER> <OPERATOR
VALUE="OR"> <FILTER "[Level Object definition]"> <CONDITION OPERATORCONDITION="Operator"> <CONSTANT Level Attribute="Value"/>
</CONDITION> </FILTER> <FILTER "[Level Object definition]"> <CONDITION OPERATORCONDITION="Operator"> <CONSTANT Level
Attribute="Value"/> </CONDITION> </FILTER> </OPERATOR> </OPERATOR> 56 Using SAP NetWeaver Business Intelligence in Universe Designer
Customizing OLAP universes Optional prompts in OLAP universes 6 Optional prompts in OLAP universes Universes generated from OLAP data sources
support optional prompts. For SAP NetWeaver BW optional variables, filters with the optional conditions are automatically generated in the universe. In predefined conditions or in an object's WHERE clause, to make a prompt optional, embed the XML filter expression between the two XML tags: <OPTIONAL>
and </OPTIONAL>. Example: Optional prompt in a pre-defined condition <OPTIONAL> <FILTER KEY="[Products].[Family]" > <CONDITION
OPERATORCONDITION="InList" > <CONSTANT CAPTION="@prompt('Enter value(s) for Product family:','A','Products\Family',Multi,primary_key,per
sistent)"/> </CONDITION> </FILTER> </OPTIONAL> Related Topics · To manually create predefined conditions in an OLAP universe on page 54 To
improve performance of certain queries on SAP NetWeaver BW universes For queries on SAP NetWeaver BW universes that include only the key and medium
name detail objects of a dimension, you can modify the generated syntax of the objects to improve query performance.
To modify the syntax: 1. Open the universe in Designer. 2. Double click the key detail object you want to modify. 3. In the Select text box on the "Definition"
tab of the "Edit Properties" dialog box, change the syntax to refer to the NAME attribute of the SAP characteristic.
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